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Abstract

These Application Notes describe the steps necessary for configuring Session Initiation
Protocol (SIP) Trunk Service for an enterprise solution using Avaya IP Office Release 9.0 to
interoperate with Nextiva SIP Services (NextOS).

The test was performed to verify SIP trunk features including basic calls, call forward (all
calls, busy, no answer), call transfer (blind and consult), conference, and voice mail. The calls
were placed to and from the PSTN with various Avaya endpoints.

Nextiva SIP Trunk Services (NextOS) provides PSTN access via a SIP trunk between the
enterprise and Nextiva’s network as an alternative to legacy analog or digital trunks. This
approach generally results in lower cost for the enterprise.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Nextiva is a member of the Avaya DevConnect Service Provider Program. Information in
these Application Notes has been obtained through DevConnect compliance testing and
additional technical discussions. Testing was conducted via the DevConnect Program at the
Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the steps necessary for configuring Session Initiation Protocol
(SIP) Trunk Service for an enterprise solution using Avaya IP Office Release 9.0 to interoperate
with Nextiva SIP Services (NextOS).

In the sample configuration, the Avaya IP Office solution consists of Avaya IP Office (hereafter
referred to as IP Office) 500v2 Release 9.0 and various Avaya endpoints, including Avaya IP
Office Video Softphone, Avaya Flare® Experience for Windows and Avaya deskphones,
including SIP, H.323, digital, and analog.

The Nextiva SIP Trunking Service referenced within these Application Notes is designed for
business customers. Customers using this service with the Avaya IP Office solution are able to
place and receive PSTN calls via a broadband WAN connection using the SIP protocol. This
converged network solution is an alternative to traditional PSTN trunks such as analog and/or
ISDN-PRI trunks. This approach generally results in lower cost for the enterprise.

The terms “Service Provider” and “Nextiva” will be used interchangeable throughout these
Application Notes.

2. General Test Approach and Test Results

The general test approach was to connect a simulated enterprise site to Nextiva’s network via the
public Internet and exercise the features and functionalities listed in Section 2.1. The simulated
enterprise site was comprised of Avaya IP Office Release 9.0 and various Avaya endpoints,
listed in Section 4.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

To verify SIP trunk interoperability, the following features and functionalities were covered
during the interoperability compliance test:
« SIP Trunk Registration (Dynamic Authentication).
e Response to SIP OPTIONS queries (SIP OPTIONS sent by IP Office).
e Incoming PSTN calls to various Avaya endpoints, including SIP, H.323, digital and
analog at the enterprise. All incoming calls from the PSTN were routed to the enterprise
across the SIP Trunk from the service provider networks.
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Outgoing PSTN calls from Avaya endpoints including SIP, H.323, digital and analog
telephones at the enterprise. All outgoing calls to the PSTN were routed from the
enterprise across the SIP trunk to the service provider network.

Incoming and outgoing PSTN calls to/from Avaya IP Office Video Softphone.
Incoming and outgoing PSTN calls to/from Avaya Flare® Experience for Windows.
Dialing plans including local calls, international, outbound toll-free, etc.

Caller ID presentation.

Proper disconnect when the caller abandons the call before the call is answered.

Proper disconnect via normal call termination by the caller or the called parties.

Proper disconnect by the network for calls that are not answered (with voicemail off).
Proper response to busy endpoints.

Proper response/error treatment when dialing invalid PSTN numbers.

Proper codec negotiation and two way speech-path. (Testing was performed with codecs:
G.711U, G.711A and G.729A, Nextiva preferred codec order).

No matching codecs.

G.711 fax pass-through.

Proper early media transmissions.

Voicemail and DTMF tone support (leaving and retrieving voice mail messages from
PSTN phones).

Outbound Toll-Free calls, interacting with IVR (Interactive VVoice Response systems).
Calling number blocking (Privacy).

Call Hold/Resume (long and short duration).

Call Forward (unconditional, busy, no answer).

Blind Call Transfers.

Consultative Call Transfers.

Station Conference.

Mobility twinning of incoming calls to mobile phones.

Items not supported or not tested included the following:

Nextiva does not support T.38 fax; only G.711 fax pass-through is currently supported.
Nextiva does not support Operator (0) and Operator-Assisted (0 + 10-digits) calls.
Inbound toll-free calls were not tested.

911 Emergency calls were not tested.
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2.2. Test Results

Interoperability testing of Nextiva SIP Services was completed with successful results for all test
cases with the exception of the observations/limitations described below.

Outbound Calling Party Number (CPN) Blocking: To support user privacy on
outbound calls (calling party number blocking), when enabled by the user, IP Office
sends “anonymous” as the calling number in the SIP “From” header and includes
“Privacy: id” in the INVITE message. During the compliance test, Nextiva’s network
responded with “403 forbidden” to outbound calls with privacy enabled, resulting on the
call failing to complete. For user authentication/validation, Nextiva utilizes the content
(number) in the “FROM” header of the INVITE message sent by IP Office, instead of the
content (number) in the “PAI” header of the INVITE message sent by IP Office, thus
causing call authentication failure, with a response of “403 forbidden”.

Caller ID display for calls from IP Office to the PSTN: For Caller ID display for calls
from IP Office to the PSTN, Nextiva utilizes the content (number) in the “PAI” header of
the INVITE message sent by IP Office, instead of the content (number) in the “FROM”
header of the INVITE message sent by IP Office. IP Office was configured to meet this
requirement under the SIP Line - SIP URI Tab (Refer to Section 5.4.4).

Blind Call Transfer using SIP phones do not complete until after the transferee
answers the call: When Blind Transfers are executed from Avaya 1100 Series SIP
phones the transfer does not complete until after the end user (transferee) answers the
call. Scenario: A PSTN user calls an IP Office SIP extension (Avaya 1100 Series SIP
phone), the call is answered. The IP Office user then proceeds to do a blind transfer to
another endpoint. Result: The expected behavior on the Avaya 1100 Series SIP phone is
to display “transfer completed” after answering “N0” to the question “Consultative
transfer with party?” which implies a blind transfer. Instead, the Avaya 1100 Series SIP
phone continues to display “transferring” until the transferee answers the call. This is a
known issue with the Avaya 1100 Series phone, the work around is to hang up the SIP
phone. There is no user impact, the transfer completes successfully. This issue is only
seen with the Avaya 1100 Series phones.

Caller ID display on Mobile station used for Mobile Twinning and Call Forwards:
For calls from the PSTN to IP Office extensions configured with Mobile Twinning, the
Caller ID display at the Mobile station was of the “Host Station” DID number assigned to
the IP Office extension, instead of the PSTN number originating the call. For calls being
forwarded in IP Office, the Caller ID display at the PSTN phone was also of the “Host
Station” DID number assigned to the IP Office extension, instead of the PSTN number
originating the call.

Unsupported audio codecs: Nextiva responds with “404 Not Found” to unsupported
audio codec offers, instead of “488 Not Acceptable Here”. There is no user impact, it is
being noted here simply as an observation.

OPTIONS Response: On the test circuit used for the compliance test, Nextiva responded
to OPTIONS from IP Office with "403 Forbidden" instead of "200 OK". For Nextiva to
respond to OPTIONS with “200 OK”, it requires that the OPTIONS message contain an
Authorization header, but Avaya IP Office cannot be configured to satisfy this
requirement. However, IP Office treats any response to OPTIONS as an indication that
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the far end is active and responding, therefore will not take the SIP connection to the far
end out of service. This OPTIONS response is listed here simply as an observation since
it had no impact on the status of the SIP connection between IP Office and Nextiva.

e Direct Media: Avaya IP Office R9.0 offers a new Direct Media capability on IP Office
500 V2 that allows IP endpoints to send RTP media directly to each other rather than
having all the media flow through the IP Office, using up VolIP and relay resources. This
capability is not supported on the configuration described in these Application Notes
where Avaya IP Office connects to the service provider network via a direct public
Internet connection without using an enterprise Session Border Controller.

2.3. Support
For support on Nextiva systems visit the corporate Web page at: http://www.nextiva.com/

Avaya customers may obtain documentation and support for Avaya products by visiting
http://support.avaya.com. Alternatively, in the United States, (866) GO-AVAYA (866-462-8292)
provides access to overall sales and service support menus.
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3. Reference Configuration

Figure 1 illustrates the test configuration used for the DevConnect compliance testing. The test
configuration simulates an enterprise site with an Avaya SIP-enabled enterprise solution
connected to the Nextiva SIP trunk service through the public Internet.

The Avaya components used to create the simulated enterprise customer site includes:
e Avaya IP Office 500v2.

Avaya Voicemail Pro for IP Office.

Avaya 96x0 Series H.323 IP Deskphones.

Avaya 96x1 Series H.323 IP Deskphones.

Avaya 1100 Series SIP IP Deskphones.

Avaya IP Office Video Softphone.

Avaya Flare® Experience for Windows.

Avaya 1408 Digital Deskphones.

Avaya 9508 Digital Deskphones.

Analog Deskphone.

Fax Machines.

The enterprise site contains the Avaya IP Office 500v2 with analog and digital extension
expansion modules, as well as a VCM®64 (Voice Compression Module) for supporting VolP
codecs. The LANL1 port of Avaya IP Office is connected to the enterprise LAN (private IP
network) while the LAN2 port is connected to the public IP network. Endpoints include Avaya
96x0 and 96x1 Series IP Deskphones (with H.323 firmware), Avaya 1100 Series IP Deskphones
(with SIP firmware), Avaya 1408 and 9508 Digital Deskphones, Analog Deskphones, Fax
Machines, PCs running Avaya IP Office Softphone and IP Office Flare® Experience for
Windows. The site also has a Windows PC running Avaya IP Office Manager to configure and
administer the Avaya IP Office system, and Avaya Voicemail Pro providing voice messaging
service to the Avaya IP Office users. Mobile Twinning is configured for some of the Avaya IP
Office users so that calls to these user’s extensions will also ring and can be answered at the
configured mobile phones.

For the purposes of the compliance test, users dialed a short code of 9 + N digits to make calls
across the SIP trunk to Nextiva. The short code 9 was stripped off by Avaya IP Office but the
remaining “N” digits were sent unaltered to the network. Refer to Section 5.5.

In an actual customer configuration, the enterprise site may include additional network
components between the service provider and the Avaya IP Office system, such as a session
border controller or data firewall. A complete discussion of the configuration of these devices is
beyond the scope of these Application Notes. However, it should be noted that all SIP and RTP
traffic between the service provider and the Avaya IP Office system must be allowed to pass
through these devices.
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For confidentiality and privacy purposes, public IP addresses, user names, passwords and
routable DID numbers used during the compliance testing have been masked.

Service Provider

-
(.
Internet
T

Nextiva SIP trunk Registration Credentials . . ™
Username: 5203661749 ?;r,ﬂ;f,!a:fd 5:‘:2?:1"59
Auth, Name:  AName123 P :_5‘3 o 1740
Password: Password123 a: 520414:2303

FQDN: bt voipdnsservers.com 520-414.3589

Public DNS: Primary:  10.5.216.122 EZEERE=W £ nterprise Firewall 520-414-4719

Secondary: 10.5.153.242

192.168.157.186

Avaya IP Office 500 V2.

Avaya 96x1 Series
IP Deskphones
[H.323)

- IP Office Manager

- Voice Mail Pro Avaya 96x0 Series
Fax - Avaya IP Office Video I;ﬁlr:laskphonss A;:f;: TPW
s Softphone (SIP) {H.323) Desklphones
- ([ Experience (SIP}
Analog Avaya 9508, 1408 Avaya Flare
Deskphones Digltzla Deskphones for Windows (81F)
p. iy
Figure 1: Avaya Interoperability Test Lab Configuration
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4. Equipment and Software Validated
The following equipment and software were used for the sample configuration provided:

Equipment/Software | Release/Version
Avaya
Avaya IP Office 500v2 9.0.4.0 Build 965
Avaya IP Office DIG DCPx16 V2 9.0.4.0 Build 965
Avaya IP Office Manager 9.0.4.0 Build 965
Avaya Voicemail Pro Client 9.0.4.0 Build 18
Avaya 96x0 IP Deskphones (H.323) Avaya one-X® Deskphone Edition
S3.220A
Avaya 96x1 Series IP Deskphones (H.323) Avaya one-X® Deskphone H.323
Version 6.4014
Avaya 1120E IP Deskphones (SIP) SIP1120e Ver. 04.04.14.00
Avaya IP Office Video Softphone 3.2.3.49 68975
Avaya Flare® Experience for Windows 1.1.4.23
Avaya Digital Deskphones 1408 38.0
Avaya Digital Deskphones 9508 0.55
Lucent Analog Phone -
Nextiva
Broadworks Broadsoft Application Server R17 SP4
ACME Packet SBC (4500) 6.2

Testing was performed with Avaya IP Office

500 V2, but this testing also applies to Avaya IP

Office Server Edition running the same software release. Note that Avaya IP Office Server
Edition requires an Expansion IP Office 500 V2 R9 to support analog or digital endpoints or

trunks.
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5. Configure Avaya IP Office

Avaya IP Office is configured through the Avaya IP Office Manager PC application. From the
Avaya IP Office Manager PC, select Start - Programs - IP Office - Manager to launch the
application. A screen that includes the following may be displayed.

WELCOME to IP Office Administration

What would you like to do?

Create an Offline Configuration

| Open Configuration from System|

Read a Configuration from File

Select Open Configuration from System. If the above screen does not appear, the
configuration may be alternatively opened by navigating to File > Open Configuration at the
top of the Avaya IP Office Manager window. Select the proper Avaya IP Office system from the
pop-up window and log in with the appropriate credentials.

The appearance of the IP Office Manager can be customized using the View menu. In the
screens presented in this document, the View menu was configured to show the Navigation pane
on the left side, omit the Group pane in the center, and show the Details pane on the right side.
Since the Group pane has been omitted, its content is shown as submenus in the Navigation pane.
These panes (Navigation, Group and Details) will be referenced throughout the Avaya IP Office
configuration. All licensing and feature configuration that is not directly related to the interface
with the service provider (such as twinning and IP Office Video Softphone support) is assumed
to already be in place.

In the sample configuration, the MAC address 00E00706530F was used as the system name. All
navigation described in the following sections (e.g., License = SIP Trunk Channels) appears
as submenus underneath the system name 00E00706530F in the Navigation Pane.
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5.1. Licensing and Physical Hardware

The configuration and features described in these Application Notes require Avaya IP Office to
be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License in
the Navigation pane. Confirm a valid license with sufficient Instances (trunk channels) in the
Details pane. Note that the full License Keys in the screen below is not shown for security
purposes.

IP Offices !

& BOOTP (3) License ‘Remote Server
« Qpera

-

License Mode License Normal

= System (1)
#-57 Line (3) PLDS HostID 111309
[#-== Control Unit (4)
[i-4& Extension (37) - -
F-§ User (32) Feature License Key Instances Status Expiry Date Source
Sjﬁ g;g‘fc%g‘e ) Small Office Edition VCM (c.. 2KO78F6LVX4U... 255 Obsolete Never ADI Nodal
-8 Service (0) Small Office Edition WiFi eAWwWB35VO).. 255 Obsolete Never ADI Nodal
Sg ﬁgrﬁl%q Call Route ) IPSec Tunnelling MIKcnX§MKys... 255 Valid Never ADI Nodal
23] WAN Port (0) Proactive Reporting ttDp8nbsAN@... 255 Valid MNever ADI Nodal
e %‘rfgtlfrgﬁﬁ? © Report Viewer Tvct73mdgdGt.. 255 Valid Never ADI Nodal
E]--@ Firewall Profile (1) Mobility Features OICIURgHVKOxL.. 255 Obsolete Never ADIModal
v oute ©) o © Advanced Small Communit.. DaQJI7VeSvUU.. 255 Obsolete Never ADINodal
[-® License (74) IP500 Voice Networking Ch.. T39BkqBXvdéa.. 255 Valid Never ADI Nodal
D‘_‘\ U‘;Q?Eiqms ® IP500 Upgrade Standard to.. QaHgn76vaj6C.. 255 Obsalete Never ADI Nodal
EJ--'K’ ARS (1) IP500 Voice Networking Ch... JaHLHAVFX)D.. 4 Valid Never ADI MNodal
- fisatligﬂf)” Request (0) SIP Trunk Channels 13CQzGBYDUsc... 255 Valid Never ADI Nodal
VPN IP Extensions @gm3fOoR55_... 255 Obsolete MNever ADI Nodal
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To view the physical hardware comprising Avaya IP Office, expand the components under the
Control Unit in the Navigation pane. In the sample configuration, the Avaya IP Office 500v2 is
equipped with analog and digital extension expansion modules, as well as a VCM64 (Voice
Compression Module) for supporting VolP codecs. An Avaya IP Office hardware configuration

with a VCM component is necessary to support SIP trunking.

To view the details of the component, select the component in the Navigation pane. The
following screen shows the details of the IP 500 V2.

IP Offices

IP 500 V2

+

+

+

+

+

+

+

+

+

+

+

+]-4

=) Ry

#-& BOOTP (3)

Operator (3)
00E00706530F
%2 System (1)
T4 Line 3)
“2 Control Unit (4)
-
“= 2VCM64/PRID U
= 3 PHONES
“= 6 DIG DCPx16 V2
4 Extension (38)
i User (32)
a Group (1)
#X% Short Code (65)
D Service (0)
o RAS (1)

- Incoming Call Route (2)

€2 WAN Port (0)

@= Directory (0)

£ Time Profile (0)
@ Firewall Profile (1)
KB 1P Route (5)

#m Account Code (0)
W License (74)

W& Tunnel (0)

§3 UserRights (8)
‘€ ARS (1)

#~ RAS Location Request (0)

& Location (0)

Unit

Device Number

Unit Type

Version

Serial Number

Unit IP Address
Interconnect Number

Module Number

1

IP 500 V2

9.0.300.941

“

172.16.5.60

0

Control Unit
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5.2. System

Configure the necessary system settings. In an Avaya IP Office the LAN2 tab settings
correspond to the Avaya IP Office WAN port (public network side) and the LAN1 tab settings
correspond to the LAN port (private network side).

5.2.1. System — LAN2 Tab

In the sample configuration, the Avaya IP Office WAN port was used to connect to Nextiva.

The LANZ2 settings correspond to the WAN port on the Avaya IP Office 500 V2. To access the
LANZ2 settings, first navigate to System - <Name>, where <Name> is the system name
assigned to the Avaya IP Office. In the case of the compliance test, the system name is the MAC
address 0OE00706530F. Next, navigate to the LAN2 - LAN Settings tab in the Details Pane.
Set the IP Address field to the public IP address assigned to the Avaya IP Office WAN port. Set
the IP Mask field to the mask used with the public IP address. All other parameters should be
set to default or according to customer requirements. Click Ok to commit (not shown).

IP Offices |E 00E00706530F

= K BOOTP (3) System | LAN1 |LAN2 | DNS | Voicemail | Telephany | Directory Services | System Events [smrp | smDR | Twinning[vem  [ccr | codecs | accs |
*-¢+ Operator (3)

%)% ODEQ0706530F LAN Settings |VoIP | Network Topalogy|

=% System (1)

“% 00E00706530F
+-T4 Line (3)
<= Control Unit (4)
+-4& Extension (37) IP Mask 255 . 255 . 255 . 192

IP Address 192 . 168 . 157 . 186

% User (32)
%k Group (1) R
8 Short Code (65) Primary Trans. IP Address ] 0 0 0
@ Service (0)

o RAS (1) Firewall Profile ‘<Nune> - ‘
-@ Incoming Call Route (2)

£ WAN Port (0)
== Directory (0)
£ Time Profile (0)
@ Firewall Profile (1) Enable NAT
-l IP Route (6)
&= Account Code (0 =
S Liicﬁg (75) &0 MNumber Of DHCP IP Addresses 1 =
gﬂ Tunnel (0)
&3 User Rights (8)

¢ ARS (1) DHCP Mode
# RAS Location Request (0)
& Location (0)

RIP Mode [None -

B

Server Client Dialin @ Disabled Advanced
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On the VoIP tab in the Details Pane, configure the following parameters:
e Check the SIP Trunks Enable box to enable the configuration of SIP trunks.

e The RTP Port Number Range can be customized to a specific range of receive ports for
RTP media. Based on this setting, Avaya IP Office would request RTP media be sent to

a UDP port in the configurable range for calls using LANZ.

IP Offices

| .

00E00706530F

&K BOOTP (3)

E-g#+ Operator (3)
= 00E00706530F

H-<22 Control Unit (4)
r--4 Extension (37)
0§ User(32)
]--@ Group (1)
5@ Short Code (65)
@ Service (0]
Tl RAS (1)
£ e Incoming Call Route (2)
-$8 WAN Port (0)
= Directory (0]

7 Time Profile (0)
£ Firewall Profile (1)
o-Jill IP Route (6)

8 Account Code (0)
% License (74)
-4 Tunnel (0)
£ 'a‘, User Rights (8)
2 ARS (1)
- RAS Location Request (0)
- Location (0)

| system | Lant [ LANZ [oNs | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning [ veM | €CR | Codecs | accs |

LAN Settlngsl VelP I Metwork Tnpology|

[T] H323 Gatekeeper Enable

Auto-create Extn

SIP Trunks Enable

[] SIP Registrar Enable

Auto-create Extn/User

10

Auto-create User

upp

TCP

TLS

15060

15060

15061

H323 Remote Extn Enable

SIP Remote Extn Enable

RTP
Port Mumber Range

Minimurn

Port Mumber Range (NAT)

Minirmum

Maximum

Masxirnum

53246

53246
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Scroll down the page.

e Inthe RTP Keepalives section, set the Scope to RTP. Set the periodic timeout to 30 and
the Initial Keepalives parameter to Enabled. These settings will cause Avaya IP Office
to send a RTP keepalive packet starting at the time of initial connection and every 30
seconds thereafter if no other RTP traffic is present. This facilitates the flow of media in
cases where each end of the connection is waiting to see media from the other, as well as
helping to keep firewall ports open for the duration of the call.

e Inthe DiffServ Settings section, Avaya IP Office can also be configured to mark the
Differentiated Services Code Point (DSCP) in the IP Header with specific values to
support Quality of Services policies for both signaling and media. The DSCP field is the
value used for media and the SIG DSCP is the value used for signaling. The specific
values used for the compliance test are shown in the example below and are also the
default values. For a customer installation, if the default values are not sufficient,
appropriate values will be provided by the customer.

e All other parameters should be set to default or according to customer requirements.

e Click Ok to commit (not shown).

I Avaya IP Office Manager 00E00706530F [9.0.400.965] [Administrator{Administrator]]
File Edit View Tools Help
IP Offices IE 00E00706530F
+’S gOOTf (3(]3] ‘ System | LANL | LANZ IDNS |Vn|(ema|\ |Talephnny Directory Services | System Eventsl SMTP | SMDR |Twmn|ng | VCM | CCR | Codecs | ACCS ‘
~{#% Qperator
- ‘ LAN Settmgsl ValP |NetworlcTDpoIogy|
RTP
. Port Number Range

H-<= Control Unit (4)

H-4 Extension (37) Minimum 49152 = Maximum 53246 -

w-f  User (32)

5§ Group (1) Port Number Range (NAT)

+-8% Short Code (65) — —

@ Service (0) Minimum 49152 Maximum 53246 =

-, RAS (1)

+ e Incoming Call Route (2) | Enable RTCP Monitering on Port 5005

@ WAN Port (0) Keepalives
Directory (0)
! Time Profile (0) Scope RTP ¥ | Periodic timeout 30

@) Firewall Profile (1)

- ll 1P Route (6) Initial keepalives Enabled -

- Account Cede (0)

% License (74)

- Tunnel (0

+-§3 User Rights (8) DiffServ Settings

¢ ARS (1) . . . .

" RAS Location Request (0) E8 =| DSCP(Hex) B = Video DSCP(Hex) FC = DSCP Mask (Hex) |88 = | SIG DSCP (Hex)

i@ Location (0)

4 7| psce 46 7] Video DSCP 63 3] DSCPMask 3 [T SIGDSCP
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On the Network Topology tab in the Details Pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. Since no firewall or network address translation (NAT) device was used
between the Avaya IP Office and the Nextiva, the parameter was set to Open Internet.

e Set the Binding Refresh Time (seconds) to a desired value, the value of 300 (or every 5
minutes) was used during the compliance testing. This value is used to determine the
frequency that IP Office will send OPTIONS heartbeat to the service provider.

e Set Public IP Address to the IP address of the Avaya IP Office WAN port.

e Inthe Public Port section, next to the transport protocol UDP, select the UDP port on
which Avaya IP Office will listen.

e All other parameters should be set to default or according to customer requirements.

e Click Ok to commit (not shown).

IP Offices = 00E00706530F

7~ BOOTP (3) | System | Lant | LANZ |pis | Voicemail | Telephony | Directory Services | System Events | sMTP [ sMDR [ Twinning [vem | ccR [ codecs [ Accs |
« Operator (3)

DOE00706530F | LAN Settings | Vol | Network Topology ||

00EDO706530F Metwork Topology Discovery
=T Line (3) STUN Server Address 60.90.168.13 STUNPort 3478
#-+= Control Unit (4)
-4 Extension (37) Firewall/NAT Type Open Internet -
=-§ User32)
- 4§ Group (1) Binding Refresh Time (seconds) 300 =
=-8% Short Cade (65)
ublic ress un ancei

@ service (0) Public IP Add 192 . 168 157 . 186 Run STUN Cancel
s RAS (1)
E e Incoming Call Route (2) Public Port
&8 WAN Port (0)

@ Directory () uoe 5060

£ Time Profile (0)

=-{@ Firewall Profile (1)
=-Jll IP Route () TLS 0
-l Account Code (0)

TCP 5060

- License (74) Run STUN on startup
- Tunnel (0)

X ﬁ‘, User Rights (8)
- ARS (1)

@ RAS Location Request (0)
-~ Location (0)

Note: In the compliance test, the LANL1 interface was used to connect the Avaya IP Office to the
enterprise site IP network (private network). The LANL1 interface configuration is not directly
relevant to the interface with the Nextiva SIP Trunk Service, and therefore is not described in
these Application Notes.
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5.2.2. System - Telephony Tab

To access the System Telephony settings, navigate to the Telephony - Telephony tab in
the Details Pane. Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call
forwarding and call transfer to the PSTN. If for security reasons incoming calls should not
be allowed to transfer back to the PSTN then leave this setting checked. All other parameters
should be set to default or according to customer requirements. Click OK to commit (not

shown).

IP Offices

00E00706530F

K BOOTP(3)
-':;" Operator (3)

=] 00706530F

(-2 Contrel Unit (4)
-4 Extension (37)
=-f  User 32)
E-43§ Group (1)
8% Short Code (65)
4B Service (0)
oy RAS (1)
e Incoming Czll Route (2)
45 WAN Port (0)
@ Directory (0)
-£1% Time Profile (0)
=@ Firewall Profile (1)
i=-[ill IP Route (6]
- Account Code (00
% License (74)
- Tunnel (0
=-§3 User Rights (8)
B¢ ARS (1)
- RAS Location Request {0)
58 Location (0)

| System | LaNt [ LAN2 [DNS | Veicemail| Telephony | Directory Services | System Events | SMTP | SMDR | Twinning [veM [ ccR | Codees | Accs |

Dial Delay Time (secs)

Dial Delay Count

Default Mo Answer Time (secs)
Hold Timeout (secs)

Park Timeout (secs)

Ring Delay (secs)

Default Currency
Default Name Priority

Media Connection Preservation

3

=

15

0

300

5

usp

| (DD (TR (T T

Call Priority Promotion Time (secs) |Disabled

-

Disabled A

Telepheny I Park & Pagel Tones & Mus\cl Ring Tones | SM | Call Log | TUI |
Analogue Extensions Companding Law
Switch Line
Default Outside Call Sequence
Default Inside Call Sequence Ring Typel - @ U-law @ U-LawLine
Default Ring Back Sequence Ring Type 2 -
X X @ A-Law @ A-Law Line
Restrict Analogue Extension Ringer Voltage =

[ DSS Status
Aute Hold
Dial By Name

Show Account Code

||:| Inhibit Off-Switch Forward/Transfer

[ Restrict Metwork Interconnect

[7] Drop External Only Impromptu Conference

[] Visually Differentiate External Call

|| Unsupervised Analog Trunk Disconnect Handling
High Quality Cenferencing

[ Strict SIPS

Digital/Analogue Auto Create User
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5.2.3. System - Twinning Tab

To view or change the System Twinning settings, navigate to the Twinning tab in the Details
Pane as shown in the following screen. The Send original calling party information for
Mobile Twinning box is not checked in the sample configuration, and the Calling party
information for Mobile Twinning is left blank. Click OK to commit (not shown).

I Avaya IP Office Manager 00ED0706330F [9.0.400.965] [Administrator{(Administrater)]
File Edit View Tools Help

IP Offices |E 00ED0706530F

@R 800TP 3) | system [ Lana | Lan2 | DN | voicemail | Telephony | Directory Services | system Events | smp | smoR [ Twinning [vem | ccr | codecs | accs |

i Operator (3)

@

|| Send eriginal calling party information for Mebile Twinning

Calling party infermation for
Mobile Twinning

[+ Control Unit (4)
-4 Extension (37)
§ User32)
-8 Group (1)
8% Short Code (65)
4 Service (0)
- RAS (1)
@ Incoming Call Reute (2)
45 WAN Port (0)
a4 Directory (0}
£ Time Profile (0)
@ Firewall Profile (1)
&=l IP Route (6)
8 Account Code (0)
W License (74)
& Tunnel (0)
=-f4 User Rights (8)
- ARS (1)
-« RAS Location Request (0)
-8 Location (0)
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5.2.4. System — Codecs Tab

e Inthe Codecs tab of the Details Pane, select or enter 101 for RFC2833 Default Payload.
This setting was recommended by Nextiva for use with out-band DTMF tone
transmissions.

e For Codec Selection, select the codecs and codec order of preference on the right, under
the Selected column. The example below shows the codecs used for the compliance test.
Note that System Default Codec Selection was used under the SIP Line - VoIP Tab in
Section 5.4.5, which corresponds to the codec setting shown here. The list must include
G.711 ULAW, G.711ALAW and G.729(a) which are the codecs supported by Nextiva.
Codecs are listed in preferred codec order (from top to bottom).

IP Offices |E 0OE00706530F

=R 800TP () | Syrsherm | LANL | LaM2 | DMNE |Vo|cema|\ |Te|ephony Directary Services | Systermn Events | SMTP | SMDR |Twmn|ng | W | CCR | CUdECSiACCS ‘

=5 Operator (3)

= |RFC2833 Default Payload 101 = |
Available Codecs Default Codec Selection
B L _ Unused Selected
:¢ g””tm‘u”;‘?“‘) ] G711 ULAW 64 G722 64K srx || [E 711 0LAW 4K
1 um”‘a‘;”( J ] G.TLL ALAW G4 6.723.16K3 MP-MLQ GTLLALAW 64K
i Gs”( ; ] G722 54K 6.729¢a) 8K C3-ACELP
] S;z‘:tpc(oze - 7] G.729(a) 8K CS-ACELP
: V] 5.723.1 6K3 MP-ML
@ Service (0) Q e
ol RAS (1)

+e Incoming Call Route (2)
B WAN Part (D)

-am Directory (0) E3
( ime Profile {0}

-8} Firewsall Profile (1)

+-ll 1P Route (6)

Ml Account Code (0)

Q; License (74

i Tunnel (0

+ a‘, User Rights (&)

- ARS (1)

- RAS Location Request (I
i@ Location (1)
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5.3. IP Route

Create an IP route to specify the IP address of the gateway or router where the IP Office needs to
send the packets in order to route calls to Nextiva’s network.

Navigate to IP Route - 0.0.0.0 in the left Navigation Pane if a default route already exists,
otherwise, to create the default route, right-click on IP Route and select New. Create/verify a
default route with the following parameters:

e Set IP Address and IP Mask to 0.0.0.0.

e Set Gateway IP Address to the IP address of the default router for the public network

where Avaya IP Office is connected.
e Set Destination to LAN2 from the drop-down list.
e Click the OK to commit (not shown).

IP Offices | EZ 0.0.0.0°

- R BOOTP (3) IP Route
+-4# Operator (3)
=-%% 00E00706530F IP Address
%2 System (1)

r
+
+-
+
+

4 Line 3)
Control Unit (4)
& Extension (38)
i User (32)

+-5af Group (1)
+-8% Short Code (65)

@ Service (0)

IP Mask 0 0 0 0

Gateway IP Address

Destination

192 168 157

129

LAN2

Metric 0
[”] Proxy ARP

+-oflg RAS (1)

* e Incoming Call Route (2)
€ WAN Port (0)
@ Directory (0)
£ Time Profile (0)

+ Firewall Profile (1)
={lill IP Route (5)
1 1]0.000
10.10.10.0

il 17216.50
192.168.10.0
192.168.99.0
@m Account Code (0)
e License (74)
W& Tunnel (0)
+-§3 User Rights (8)
+-"¢ ARS (1)
#~ RAS Location Request (0)
& Location (0)
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5.4. SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and Nextiva SIP
Trunk Services. The recommended method for configuring a SIP Line is to use the template
associated with these Application Notes. The template is an .xml file that can be used by IP
Office Manager to create a SIP Line. Follow the steps in Section 5.4.1 to create the SIP Line
from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses.

e SIP Trunk Registration Credentials.

e SIP URI entries.

e Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary
after the SIP Line is created via the template. The resulting SIP Line data can be verified against
the manual configuration shown in Sections 5.4.2 through to 5.4.6.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls.
e Transport — Second Explicit DNS Server.
e SIP Credentials — Registration Required.

To create a SIP Line manually, right-click Line in the Navigation Pane and select New - SIP
Line; then, follow the steps outlined in Sections 5.4.2 - 5.4.6.

HG; Reviewed: Solution & Interoperability Test Lab Application Notes 20 of 40
SPOC 12/4/2014 ©2014 Avaya Inc. All Rights Reserved. NextivalPO9



5.4.1. SIP Line From Template

1. Copy the template file to the computer where IP Office Manager is installed. Rename the
template file to US_Nextiva_SIPTrunk.xml. The file name is important in locating the

proper template file in Step 5.

Verify that template options are enabled in IP Office Manager. In IP Office Manager,

navigate to File > Preferences. In the IP Office Manager Preferences window that
appears, select the Visual Preferences tab. Verify that the box is checked next to Enable

Template Options. Click OK.

%" IP Office Manager Preferences

[

Preferences ‘ Directories l Discovery | Visual Preferences | Security | Validation

Icon Size | Small

-

Multiline Tabs

| v EnableTempIateOptions|

‘ 0K ‘ Cancel ‘ ‘ Help

Import the template into IP Office Manager. From IP Office Manager, select Tools >

Import Templates in Manager. This action will copy the template file into the IP Office
template directory and make the template available in the IP Office Manager pull-down
menus in Step 5. The default template location is C:\Program Files\Avaya\IP

Office\Manager\Templates.

File Edit View [ Tools | Help
IPOff  Brersion Renumber.. SIP Line - Line 17
Line Renumber...
=& BOOTP @) —— URI[VolP [ T38 Fax[SIP Credentials
#-¢7% Operatar (3) onnect To...
= 00EDO708530F Export 3 17 £
? System (1) SCN Service User Management
bt.voipdnsservers.com In Service
Busy on Held Validation
URI Type SIp -
MSN Configuration
[ Print Button Labels Check 005
-2+ Control Uni -
i1y Extension ( [ Import Templates in Manager Call Routing Method To Header -
#-§  User 32) .
T QOriginator number for
+;“ Group (1) Country Code forwarded and twinning calls 5203661749
-@% Short Code (65)
@ Service (0) International Prefix Mame Pricrity System Default M
oy RAS (1)
=P Incoming Call Route (2) Send Caller ID IDwersion Header V] Caller ID from From header =
i-HE) WAN Port (0)
‘" em Directory 0) Association Method By Source 1P address =] SendFromin Clear ]
3% Time Profile (0) User-Agent and Server
+@ Firewall Profile (1) Headers
-l IP Route (6) —
@@ Account Code (0) Service Busy Response 486 - Busy Here -
% License (74) X L —
gl Tunnel (0) Action on CAC Location Limit | Allow Voicemail -
#-f3 User Rights (8) 7] REFERS +
T ARS (1) HPPO
i+ RAS Location Request (0) Incoming {A\ways -]
‘@ Location (0)
Outgoing [Aways -]
Method for Session Refresh IAuto VI
Session Timer (seconds) On Demand
Media Connection Preservation ID\sabIed 'I
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5.

In the pop-up window that appears (not shown), select the directory where the template
file was copied in Step 1. After the import is complete, a final import status pop-up
window (not shown) will appear stating success or failure, click OK (not shown) to
continue. If preferred, this step may be skipped if the template file is copied directly to

the IP Office template directory.

To create the SIP Trunk from the template, right-click on Line in the Navigation Pane,
then navigate to New - New SIP Trunk From Template.

IP Offices

SIP Line - Line 17

@& BOOTP (3)
3¢ Operator (3)

SIP Line Transport | s1P URI|volP [ 138 Fax|SIP Credentials|

Paste
Delete
Validate

Connect To...

++
@4

Mew from Template (Binary)
H Export as Template (Binary)

Ctrl+V

5“3 QOEOUT06530F Line Number 17
2 New > H323 Line
%]  Generate SIP Trunk Template 1P DECT Line
SIP Line
cut Chrl+X
| SM Line
"3 Copy Ctrl+C
SIP DECT Line

Ctrl+Del

MNew SIP Trunk From Template

Ctrl+T

#1-§i3 User Rights (8)
- ARS (1)

*-&B Location (0)

@ RAS Location Request (0)

Essociation Method

REFER Support

1

[ Diversion Header

-]

By SourceIP address

|

In Service
URI Type

Check 005
Call Routing Method

Originator number for
forwarded and twinning calls

Name Prierity
Caller ID from From header
Send From In Clear

User-Agent and Server
Headers

Service Busy Response

Action on CAC Location Limit  [Allow Voicemail v

e

To Header -

5203661749

System Default -

B
Lal

486 - Busy Here -

Incoming [Atways -]
Qutgoing [Atways -]
Method for Session Refresh [ Auto -

Session Timer (seconds) On Demand
Media Connection Preservation | Disabled -

In the subsequent Template Type Selection pop-up window, select United States from
the Country pull-down menu and select Nextiva from the Service Provider pull-down
menu as shown below. These values correspond to parts of the file name
(US_Nextiva_SIPTrunk.xml) created in Step 1. Click Create new SIP Trunk to finish

creating the trunk.

™| Templ

ate Type Selecticn

ESEEE)

Locale

United States (US English]

Country

Service

IUn'rted States

~)

Provider I Mextiva

v] [] Display Al

Create new S|P Trunk

Cancel

6. Once the SIP Line is created, verify the configuration of the SIP Line with the
configuration shown in Sections 5.4.2 — 5.4.6.
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5.4.2. SIP Line = SIP Line Tab

On the SIP Line tab in the Details Pane, configure or verify the parameters as shown below.
e Set ITSP Domain Name to bt.voipdnsservers.com, the domain name for Nextiva

(FQDN).

e Set Send Caller ID to Diversion header.
e Verify REFER Support checked (enabled). Set Incoming and Outgoing under REFER

Support to Always.
e Verify that In Service box is checked, the default value. This makes the trunk available

to incoming and outgoing calls.

e Verify that Check OOS box is checked, the default value. Avaya IP Office will use the
SIP OPTIONS method to periodically check the SIP Line. The time between SIP
OPTIONS sent by Avaya IP Office will use the Binding Refresh Time for LANZ2, as
shown in Section 5.2.1.

e Set the Call Routing Method to To Header.

e Set the Originator number for forwarded and twinning calls to 5203661749. This is
the user name credentials provided by Nextiva for SIP Trunk registration purposes. This
setting was required for forwarded and twinned calls to be accepted by Nextiva. SIP
Trunk registration credentials information should be provided by Nextiva.

e All other parameters should be set to default or according to customer requirements.

e Click OK to commit (not shown).

IP Offices

: BOOTP (3)
t-{7 Operator (3)
* DOEOOT06530F

SIP Line - Line 17

SIP Line [Transport|SIP URI|VolP |38 Fax|SIP Credentials|

Line Number

17 =

|ITSP Domain Name btwveipdnsservers.com | IIn Service v I
+ 1 Line (3)
<% Control Unit (4) URI Type |51p v|
-4 Extension (37)
w-f User (32) Prefix Check 005 F
i 2% Group (1)
+-@% Short Code (65) Mational Prefix Call Routing Methad |T0 Header - ‘
- Service [0) -
: 0 t ber f
S ; Fi AN
£ @ Incoming Call Route (2)
o International Prefix ame Priori Systern Default 7
@ WAN Port (0) Name Priority |),r ‘
- Directory (0)
(ﬁ Time Profile (0) Send CallerID |Divar;\on Header - ” Caller 1D from From header
+ @ Firewall Profile (1) -
-ll TP Route (6) Association Method |By Source IP address v| Send From In Clear
-8m Account Code (0) User-Agent and Server
W License (74) Headers
@& Tunnel (0)
+§ ; User Rights (8) Service Busy Response |485 - Busy Here L ‘
- ARS (1)
', RAS Location Request (0) Actien on CAC Location Limit |AHDWVDi[EmaiI v‘
~5 Location (0) 7] REFER Support
Incoming ‘Always v|
Outgoing ‘Always - |
Method for Session Refresh |Aut0 v|
Session Timer (seconds) On Demand =
Media Connection Preservation |D|sabled v|
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5.4.3. SIP Line - Transport Tab

Select the Transport tab. Set or verify the parameters as shown below.
e Leave the ITSP Proxy Address blank (IP Office will retrieve the ITSP Proxy Address
using public DNS queries).

e Set Layer 4 Protocol to UDP.
e Set Use Network Topology Info to LANZ2, the network port used by the SIP line to
access the far-end and configured in Section 5.2.1.
e Set the Send Port to 5060.
e Set Explicit DNS Server(s) to the IP addresses of the primary and secondary public DNS
Servers used by the enterprise. This information should be provided by the local ISP. IP
Office will use public DNS queries with the ITSP Domain Name provided above, under
Section 5.4.2, to obtain the public IP address of Nextiva.
e Default values may be used for all other parameters.
e Click OK to commit (not shown).

‘-‘L Avaya IP Office Manager 00E00706530F [9.0.300.941] [Administrator(Administrator)]

File Edit View Tools

Help

IP Offices

7

SIP Line - Line 17°

#- R BOOTP (3)
+-¢# Operator (3)
=-*%y 00E00706530F

+-%%9 System (1)
+
i 1
i * 2
|
+-“w Control Unit (4)
+-4 Extension (37)
#-§ User 32)
+-3@ Group (1)
+-@% Short Code (65)
@B Service (0)
ol RAS (1)
4 e Incoming Call Route (2)
€ WAN Port (0)
@ Directory (0)
£ Time Profile (0)
+-@ Firewall Profile (1)
+- [l IP Route (6)
#m Account Code (0)
- License (74)
W& Tunnel (0)
+-§3 User Rights (8)
+-"¢ ARS (1)
-« RAS Location Request (0)
‘i@ Location (0)

SIP Line| Transport [SIp URI| VolP | T38 Fax|SIP Credentials

|IT5P Proxy Address

Network Cenfiguration

Layer 4 Protocol [UDP

Use Network Topology Info ‘ LAN 2

Send Port 5060

5060

Explicit DNS Server(s) 10

5

216

g . 153 242|

Calls Route via Registrar |V

Separate Registrar
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5.4.4. SIP Line - SIP URI Tab

Two SIP URI entries must be created to match each outgoing number that Avaya IP Office will
send on this line and incoming numbers that Avaya IP Office will accept on this line.

To set the SIP URI for outgoing numbers, select the SIP URI tab, then click the Add button and
the New Channel area will appear at the bottom of the pane. To edit an existing entry, click an
entry in the list at the top, and click the Edit button. The entry was created with the parameters
shown below:

e Set Local URI to 5203661749. This is the user name credentials provided by Nextiva for
SIP Trunk registration purposes. This setting was required for user
authentication/validation purpose. For user authentication/validation purpose, Nextiva
utilizes the content (number) in the “From” header of the INVITE message, instead of the
content (number) in the “PAI” header of the INVITE message. Refer to Section 2.2.

Set Contact, Display Name and PAI to Use Internal Data.

Set Registration is set to 0: <None>.

Set Incoming Group to 0.

Set Outgoing Group to 17 (SIP Line number being used).

Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed
using this SIP URI pattern.

e Click OK to commit.

IP Offices | = SIP Line - Line 17
=& BOOTP @) |5tP Line| Transport[SIP URI[volp |38 Fex|SIP Credentials
H-i% Operator (3)
-+ (0ED0706530F Channel Groups Via Local URI Contact Display Mame PAI Credential Max Calls Add...
[ System (1) 1 17 0 1., 0: <Non... 10
2 017 1.. 520366... 0: <Non... 10 iz
Edit...
H--<2r Control Unit (4]
+-48 Extension (37)
H-f User 32)
K- Group (1)
H-@% Short Code (55)
@ Service (0)
F-al; RAS (1)
]@ Incoming Call Route (2)
@ WAN Port (0) Edit Channel
£ Time Profile (0) Via 192.168.157.186
£ Firewall Profile (1)
£l IP Route (6) Local URI 5203661749 . Cancel
8 Account Code (0) Usel D
W License (74) Contact se Internal Data -
il Tunnel (0) Use Internal Dat -
3"'&‘: User Rights @) Display Mame se Internal Data
- ARS (1) PAL Use Internal Data -
- RAS Location Request (0]
-8 Location (0) Registration 0: <MNone> -
Incerming Group 0
Qutgoing Group 17
Max Calls per Channel 10 &
HG; Reviewed: Solution & Interoperability Test Lab Application Notes 25 of 40

SPOC 12/4/2014 ©2014 Avaya Inc. All Rights Reserved. NextivalPO9



To set the SIP URI for incoming numbers, select the SIP URI tab, then click the Add button and
the New Channel area will appear at the bottom of the pane. To edit an existing entry, click an
entry in the list at the top, and click the Edit button. The entry was created with the parameters

shown below:

e Set Local URI, Contact, Display Name and PAI to Use Internal Data.

Set Registration to 0: <None>.

[ ]
e Set Incoming Group to 17 (SIP Line number being used).
[ ]

Set Outgoing Group to 0.
Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed
using this SIP URI pattern.

e Click OK to commit.

e On the next screen that appears, click OK again to commit.

IP Offices

| .

8IP Line - Line 17

: BOOTR (3)
(-4 Operator (3)
=J-*=3 Q0ED0TOR530F
a) System (1)

T 1

()
[ Control Unit (4)
[+ Extension (37)

f-§  User 32)
e
e

i3 Group (1)

@K Short Code (65)

@ Service (0)

[#-wifs RAS (1)

(-4 Incoming Call Route (2)
~¥g WAN Port (0)

- Directory (0]

£ Time Profile (0)

(-8 Firewall Profile (1)
-l IP Route ()

-l Account Code (0)

% License (74)

- Tunnel (0]

(-5 User Rights (8)

"¢ ARS (1)

- RAS Location Request (0}
i@ Location (0)

|stP Line| Transport{ SIP URI fyolp 138 Fax|SIP Credentials

il 17 0
2 017

Edit Channel
Via

Channel Groups

.o 520366...

192168157186

Via Local URI Contact Display Mame PAl Credential Max Calls
0: <Non...
0: <Mon...

10
10

Local URI
Centact

Display Mame
PAI

Registration
Incoming Group

Outgoing Group

Max Calls per Channel

Use Internal Data

Use Internal Data

Use Internal Data

Use Internal Data

0: <None> -

17

0

10 =

Add...

Remove

Edit...

K

Additional SIP URIs may be required to allow inbound calls to numbers not associated with a
user, such as a short code. These URIs are created in the same manner as shown above with the
exception that the incoming DID number is entered directly in the Local URI, Contact, and

Display Name fields.
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5.45. SIP Line - VoIP Tab

Select the VoI P tab, to set the Voice over Internet Protocol parameters of the SIP line. Set or
verify the parameters as shown below.

For Codec Selection, select System Default from the pull-down menu to use the default
list of codecs configured under Section 5.2.4. A list of the codecs in their current order of
preference will be shown on the right in the Selected column. To use a custom list of
codecs instead, select Custom under Codec Selection. If Custom is used, move
unwanted codecs from the Selected column to the Unused column. Lastly, move the
codecs up or down the list in the Selected column to achieve the desired order of
preference. The example below shows the codecs used for the compliance test. Note that
System Default Codec Selection was used. The list must include G.711 ULAW,
G.711ALAW and G.729(a) which are the codecs supported by Nextiva. Codecs are listed
in preferred codec order (from top to bottom).

Uncheck the VolP Silence Suppression box.

Uncheck Allow Direct Media Path and Force direct media with phones box. This
setting was not tested.

Check the Re-invite Supported box.

Check the PRACK/100rel Supported box.

Set the Fax Transport Support to G.711. Refer to Section 2.1.

Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones using RTP events messages as defined in RFC2833.

Default values may be used for all other parameters.

Click the OK to commit (not shown).

IP Offices | = SIP Line - Line 17

- R BOOTP (3)
-4 Operator (3)
=)+ (0E00T06530F

|5tP Line| Transportsip URI|VolP |38 Fax|SIP Credentials|

VolP Silence Suppression

Allow Direct Media Path

‘ System Default - | |

Codec Selection /| Re-invite Supported

f <= Contral Unit (4)

-4 Extension (37)

w-f User (32)

-5 Group (1)

8% Short Code (65)

4B Service (0)

-y RAS (1)

+ @ Incoming Call Route (2)
£8 WAN Port (0)

i Directory (0)

L7 Time Profile (0)

+ @ Firewall Profile (1)
=-[ll 1P Route (5)

- Account Code (0)
% License (74)

@& Tunnel (0)

+-§i3 User Rights (8)

- ARS (1)

-~ RAS Location Request (0)
i@ Location ()

G.722 64K

G.723.1 6K3 MP-MLQ

G711 ULAW 64K
G.711 ALAW 64K
6.729(a) 8K CS-ACELP

|Fa)< Transport Support ‘ G711

Location ‘ Cloud

Call Initiation Timeout (s) 4

|DTMF Support [RFC2833

Codec Lockdown

| PRACK/100rel Supported

Force direct media with phones

G711 Fax ECAN
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5.4.6. SIP Line — SIP Credentials Tab

Select the SIP Credentials tab, and then click the Add button to add the SIP Trunk registration
credentials. Set the parameters as show below.

e Set User name to 5203661749, the user name credential provided by Nextiva for SIP
Trunk registration (the user name has been masked for security reasons).

e Set Authentication Name to ANamel23, the authentication name credential provided by
Nextiva for SIP Trunk registration.

e Set Password to Password123, the password credential provided by Nextiva for SIP
Trunk registration.

e Set Expiry (mins) to a value acceptable to the enterprise. This setting defines how often
registration with Nextiva is required following any previous registration. For the
compliance test 2 minutes was used.

e Verify that Registration required is checked.

e Click the OK to commit.

IP Offices | i SIP Line - Line 17"

R BOOTP (3) SIP Line| Transport | SIP URI|VlP |38 Fax[SIP Credentials |
+ Operator (3]
= = 00E00706530F Index UserMame Authentication Name Contact Expiry (mins) Register Add...
552 System (1) 1 5203661749 ANamel23 2 Tz
i iy 0DEOOT06530F Remove
'
e L
<2 Control Unit (4)
-4 Extension (37)
-§ User32)
ﬂ Group (1}
- @% Short Code (65)
@ Service (0)
ol RAS (1)
e Inceming Call Route (2)
8 WAN Port (0)
- Directory (0)
£ Time Profile (0)
@ Firewall Profile (1)

Edit...

-Jill IP Route (6) Edit SIP Credentials
-l Account Code (0) User name 5203661749
% License (74)
- Tunnel (0} Authentication Name ANamel23 Cancel
a, User Rights (8)
¥ ARS (1) Contact
-~ RAS Location Request (0)
& Location (0) Password sssasssssns
Expiry (mins) 2 >
Registratien required
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5.5. Outbound Call Routing

For outbound call routing, a combination of system short codes and Automatic Route Selection
(ARS) entries are used. With ARS, features like time-based routing criteria and alternate routing
can be specified so that a call can re-route automatically if the primary route or outgoing line
group is not available. While detailed coverage of ARS is beyond the scope of these Application
Notes, and alternate routing was not used in the reference configuration, this section includes
some basic screen illustrations of the ARS settings used during the compliance testing.

5.5.1. Short Codes and Automatic Route Selection

To create a short code to be used for ARS, right-click on Short Code on the Navigation Pane
and select New. The screen below shows the short code 9N created (note that the semi-colon is
not used here). In this case, when the Avaya IP Office user dials 9 plus any number N, instead of
being directed to a specific Line Group ID, the call is directed to Line Group 50: Main, which
is configurable via ARS.
e Inthe Code field, enter the dial string which will trigger this short code. In this case, 9N
was used (note that the semi-colon is not used here).
e Set Feature to Dial. This is the action that the short code will perform.
e Set Telephone Number to N. The value N represents the number dialed by the user after
removing the 9 prefix. This value is passed to ARS.
e Setthe Line Group Id to 50: Main to be directed to Line Group 50: Main, this is
configurable via ARS.
e Click the OK to commit (not shown).

N—

IP Offices |E 9N: Dial
#-® BOOTP (3) || Short Code
#-¢% Operator (3)
=13 00E00706530F Code 9N
+)-%39 System (1)
44 Line (3) Feature Dial -
#-“= Control Unit (4)
-4 Extension (37) Telephone Number N
@ User (32) E . Tren .
8% Groun Line Group ID 50: Mai
=[9% Short Code (65) Locale -
X% 00
X% 01 Force Account Code
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The following screen shows the example ARS configuration for the route Main. Note the
sequence of X’s used in the Code column of the entries to specify the exact number of digits to
be expected, following the access code and the first set of digits on the string. This type of setting
results in a much quicker response in the delivery of the call by IP Office.

To create a short code to be used for ARS, select ARS - 50: Main on the Navigation Pane and
click Add.

In the Code field, enter the dial string which will trigger this short code. In this case, 1
followed by 10 X’s to represent the exact number of digits.

Set Feature to Dial. This is the action that the short code will perform.

Set Telephone Number to 1N. The value N represents the additional number of digits
dialed by the user after dialing 1 (The 9 will be stripped off).

Set the Line Group Id to the Line Group number being used for the SIP Line, in this
case Line Group ID 17 was used.

Set Locale to United States (US English).

Click OK to commit.

Edit Short Code
Code TROCOOOCON
Feature Dial -
Cancel
Telephone Number I
Line Group D 17 -
Locale United States (US English) -
Force Account Code

Repeat the above procedure for additional dial patterns to be used by the enterprise to dial out
from IP Office.
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The example highlighted below shows that for calls in the North American numbering plan, the
user dialed 9, followed by 1 and 10 digits (represented by 10 X’s). The 9 is stripped off, the
remaining digits, including the 1, are included in the SIP INVITE message IP Office sends to

Nextiva.

(" Avaya IP Office Manager D0EO0706530F [9.0.400.965] [Administrator{Administrator]]

File Edit View Tools Help

IP Offices = Main*
=K BOOTP (3) ARS
g% Operator (3]
[=--%5p DOECOTO6530F ARS RouteId 50 Secondary Dial tone
557 System (1)
7 Line (3) n SystemTone -
<= Control Unit (4) Route Name Main [ I
A& Extension (37)
a User (32) Dial Delay Time System Default (3)| Check User Call Barring
i Group (1)
8% Short Code (65)
g ;:r;n(cle) Q@ In Service Out of Service Route [c MNenex» v]
@ Incoming Call Route (2) l
~EE WAN Port (0)
--am Directory (0)
{7 Time Profile (0) Time Profile <None> — Ot of Hours Route [< MNonex> v]
@ Firewall Profile (1) l
-l IP Route (5)
@8 Account Code (0)
% License (74) Code Telephone Mumber Feature Line Group ID m Add...
;‘ Lu"";_‘ fi . 011 011 Dial Emergency 0
A e R DOLXOOOCO00 00N Dial 17 £
BXAOOCO00 an Dial 17 B
@ RAS Location Request {0} [1XXCOON0K 1N Dial 17 ]
-5 Location (0) BXHXOK 6N Dial 17
Ereeer et 3N Dial 17
280000 28M Dial 17 i
4 | m +
3 l
30 || ey Alternate Route <None> V]

HG; Reviewed:
SPOC 12/4/2014

Solution & Interoperability Test Lab Application Notes
©2014 Avaya Inc. All Rights Reserved.

31 0f 40
NextivalPO9




5.6. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP
line defined in Section 5.4. To configure these settings, first navigate to User - Name in the
Navigation Pane where Name is the name of the user to be modified. In the example below, the
name of the user is Ext3040 H323. Select the SIP tab in the Details Pane (tab not shown). The
values entered for the SIP Name allow matching of the SIP URI for incoming calls without
having to enter this number as an explicit SIP URI for the SIP line (Section 5.4.4). The SIP
Name and Contact are set to one of the DID numbers assigned to the enterprise by Nextiva. The
SIP Display Name (Alias) parameter can optionally be configured with a descriptive name. If
all calls involving this user and a SIP Line should be considered private, then the Anonymous
box may be checked to withhold the user’s information from the network. This can also be
accomplished by activating Withhold Number on H.323 Deskphones. Click the OK to commit
(not shown).

IP Offices T

iR BOOTP (3)
+-¢# Operator (3)
=-*%# 00E00706530F SIP Name 5203661749
+-4550 System (1)
- Line (3) SIP Display Mame (Alias)  Ext3040 H323
+-=e Control Unit (4)
d

User Yoicemnail | DND Short Codes | Source Mumbers | Telephony | Forwarding

-4 Extension (37) Contact 5203661749
Uszer (32)
----- ik MoUser
""" Remotefdanager Anonymous

[ 3040 B3040 H323]
----- b 3041 Ext3041 H323
----- b 3042 Ext3042 H323
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5.7. Incoming Call Route

An incoming call route maps inbound DID numbers on a specific line to internal extensions, hunt
groups, short codes, etc., within the IP Office system.

In a scenario like the one used for the compliance test, only one incoming route is needed, which
allows any incoming number arriving on the SIP trunk to reach any predefined extension in IP
Office. The routing decision for the call is based on the parameters previously configured for
Call Routing Method and SIP URI (Section 5.4.4) and the users SIP Name and Contact,
already populated with the assigned Nextiva DID numbers (Section 5.6).

5.7.1. Incoming Call Route — Standard Tab

On the Standard tab of the Details pane, enter the parameters as shown below.
e Set Bearer Capacity to Any Voice.
e Set the Line Group Id to the incoming line group of the SIP line defined in Section 5.4, in
this case Line Group ID 17 was used.
e Default values can be used for all other fields.
e Click Ok to commit (not shown).

IP Offices = 17

#- K BOOTP (3) Standard | Voice Recording { Destinations
+-4# Operator (3)
=-%%p 00E00706530F
20 System (1) T - -
41 Line @) Bearer Capability {Any Voice
~2» Control Unit (4) Line Group ID 17 -
-4 Extension (37)
_ ‘§ User(32) Incoming Number
+-53§ Group (1)
J:r % Short Code (65) Incoming Sub Address
B Service (0)
= e Incoming Call Route (2)
- e
- @0 Priority ‘1 - Low v|
-8 WAN Port (0)
a8 Directory (0) Tag

£ Time Profile (0)
+ @ Firewall Profile (1) Hold Music Source ‘ System Source v|
+-Jill IP Route (6)
- Account Code (0)
- License (74)

W Tunnel (0)
+-§3 User Rights (8)
- ARS (1)
-« RAS Location Request (0)
i@ Location (0)

arm OO OO IO s OO e R

Incoming CLI

Locale [ v

Ring Tone Override None v
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5.7.2. Incoming Call Route — Destinations Tab

Under the Destinations tab, enter “.” for the Default VValue. This setting will allow the call to be
routed to any destination with a value on its SIP Name field, entered on the SIP tab of the User,
which matches the number present on the user part of the “To” header on the incoming INVITE

message received from Nextiva. Click OK to commit (not shown).

IP Offices =
+a BOOTP (3) Standard | Voice Recurdlngl Destinations |
+-¢# Operator (3]
: ' 00EDOTOG530F TimeProfile Destination
=9 System (1) » Default Value
+-T9 Line (3)

+ = Control Unit (4}
+-4 Extension (37)
@ User (32)

-3 Group (1)
+-@% Short Code (55)
@B Service (0)

: T

- WAN Port (0)
Directory (0]
I Time Profile (0)

-8} Firewall Profile (1)

+-[ll 1P Route (6)

- Account Code (0)

; = License (74)

Tunnel (0}

+:- 3 User Rights (8)

—-f ARS (1)

----- " 50: Main

- RAS Location Request (0)
i Location (0)

5.8. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service
disruption. Click OK to proceed.

Save Configuration C=npes X

IP Office Settings
00EQ0706530F

Configuration Reboot Mode
Merge

@ Immediate
When Free
Timed

Reboot Time

15:14

Call Barring

| oK ‘ | Cancel ‘ Help
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6. Nextiva SIP Trunk Services Configuration

To use Nextiva’s SIP Trunk service, a customer must request the service from Nextiva using the
established sales processes. The process can be started by contacting Nextiva via the corporate
web site at: http://www.nextiva.com/ and requesting information.

During the signup process, Nextiva and the customer will discuss details about the preferred
method to be used to connect the customer’s enterprise network to Nextiva’s network.

Nextiva is responsible for the configuration of Nextiva SIP Services. The customer will need to
provide the public IP address used to reach the Avaya IP Office at the enterprise. In the case of
the compliance test, this is the public IP address of the Avaya IP Office WAN port (LAN2). The
customer will also need the IP addresses for the primary and the secondary public DNS servers,
these addresses can be obtained from the local ISP.

Nextiva will provide the customer the necessary information to configure Avaya IP Office
following the steps discussed in the previous sections, including:
e SIP Trunk registration credentials (User Name, Authentication Name, Password, etc.).
e Nextiva’s Domain Name (FQDN).
e DID numbers.
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7. Verification Steps

This section provides verification steps that may be performed to verify that the solution is
configured properly.

The following steps may be used to verify the configuration:
e Verify that endpoints at the enterprise site can place calls to the PSTN.
e Verify that endpoints at the enterprise site can receive calls from the PSTN.
e Verify that users at the PSTN can end active calls to endpoints at the enterprise by
hanging up.
o Verify that endpoints at the enterprise can end active calls to PSTN users by hanging up.

7.1. IP Office System Status
The following steps can also be used to verify the configuration.

Use the Avaya IP Office System Status application to verify the state of SIP connections.
Launch the application from Start - Programs - IP Office > System Status on the PC
where IP Office Manager is installed, log in with the proper credentials.

[~ H

AVAYA IP Office System Status

Help Exit About

Online | Offline

Control Unit IP Address: ByPRERED]

Services Base TCP Port: B0l

(Lo R BT I Administrator
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Select the SIP line under Trunks from the left pane. On the Status tab in the right pane, verify
the Current State is Idle for each channel.

About

Status  Utlization Summary Alarms  Registration

Peer Domain Mame: bt.voipdnsservers.com
Resolved Address: 144,74
Line Mumber: 17
Mumber of Administered Channels: 20
Mumber of Channels in Use: 0
Administered Compression: GF11Mu, GF11A, G729 A
ocations Silence Suppression: Off
Layer 4 Protocol: uDP
SIP Trunk Channel Licenses: Unlimited . .y
SIP Trunk Channel Licenses in Use: 0

SIP Device Features:

Channel Mumber URI Group Call Ref Current State Time in State
1 Idle 00:01:28
2 Idle 00:01:28
3 Idle 00:01:28
4 Idle 00:01:28
5 Idle 00:01:28
6 Idle 00:01:28
7 Idle 00:01:28
8 Idle 00:01:28
g Idle 00:01:28
10 Idle 00:01:28
11 Idle 00:01: 28
12 Idle 00:01:28
13 Idle 00:01:28
14 Idle 00:01:28
15 Idle 00:01:28
16 Idle 00:01:28
17 Idle 00:01: 28
18 Idle 00:01:28
19 Idle 00:01: 28
20 Idle 00:01:28

Select the Alarms tab and verify that no alarms are active on the SIP line.

AVAyA IP Office System Status

,:u;m' Status  Utlization Summary Alarms |Registration
irun Alarms for Line: 17 SIP bt.voipdnsservers.com
Li 1
Line: 2 Last Date Of Error Occurrences Error Description
’
A
I ing
L
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7.2. Monitor

The Avaya IP Office Monitor application can be used to monitor and troubleshoot signaling
messaging on the SIP trunk. Launch the application from Start = Programs - IP Office >
Monitor on the PC where Avaya IP Office Manager was installed. Click the Select Unit icon on
the taskbar and Select the IP address of the IP Office system under verification.

Iﬂ_ Avaya IP Office Sys™Monitor - [STOPPED]
File Edit Wiew Fikers Status Help

=& »8T| x|V @ ==

' RN

Start/Stop Trace Select
Trace Options  Unit

Clicking the Trace Options icon on the taskbar, selecting the SIP tab allows modifying the
threshold used for capturing events, types of packets to be captured, filters, etc. Additionally, the
color used to represent the packets in the trace can be customized by right clicking on the type of
packet and selecting the desired color.

All Settings =3
T1 | woomp | wPN | weN | soN | ssl | Jade |
aTM | Cal | DTE | ECont | FrameRelaw | GOD | H323 | Interface |
15SDM | Few/Lamp | Directon | Media | PFP | R2 | Routing | Services SIF |S_l,lstem|
Ewvents
¥ Sip [Vobose - I STUM [~ SIP Dect
Packetz
[~ SIP Reg/Opt R= [~ SIP Misc B=
[~ SIP Reg/Opt Tx [ SIP Misc Tx
[ SIPCallRx [~ Crn Motifp R«
[~ SIPCallTx [~ Crn Motify T=
I+ Sip Rx I hex IP Filter [nan.nnn.nnn. nnn)
¥ Sip Tx ™ hex |
Default AII| Clear All | Tab C|eam||| Tab sBmu| 86 ]| cancel
Save | Load File | Load Partial File| Select File |
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8. Conclusion

These Application Notes describe the configuration necessary to connect Avaya IP Office
Release 9.0 to Nextiva SIP Trunk Services. Nextiva SIP Trunk Services is a SIP-based Voice
over IP solution for customers ranging from small businesses to large enterprises. It provides a
flexible, cost-saving alternative to traditional hardwired telephony trunks. Nextiva SIP Trunk
Services passed compliance testing with the observations/limitations listed under Section 2.2.

9. Additional References

This section references the documentation relevant to these Application Notes. Product
documentation for Avaya IP Office, including the following, is available at:
http://support.avaya.com/

[1] IP Office 9.0.3 IP500/1P500 V2 Installation, Document Number 15-601042, Issue 29g,
October 07, 2014.

[2] IP Office Manager Release 9.0.3, Document Number 15-601011, Issue 9.0.3, May 8, 2014.

[3] Using System Status, Document Number 15-601758, Issue 09¢, August 15, 2013.

[4] IP Office Release 9.0.3 Administering Voicemail Pro, Document Number 15-601063, Issue
9.0d, July 09, 2014.

[5] Using IP Office System Monitor, Document Number 15-601019, Issue 05f, October 07, 2014.

Additional Avaya IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/

HG; Reviewed: Solution & Interoperability Test Lab Application Notes 39 of 40
SPOC 12/4/2014 ©2014 Avaya Inc. All Rights Reserved. NextivalPO9


http://support.avaya.com/
http://marketingtools.avaya.com/knowledgebase/

©2014 Avaya Inc. All Rights Reserved.
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™ are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks
are the property of their respective owners. The information provided in these Application
Notes is subject to change without notice. The configurations, technical data, and
recommendations provided in these Application Notes are believed to be accurate and
dependable, but are presented without express or implied warranty. Users are responsible for
their application of any products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya
DevConnect Program at devconnect@avaya.com.
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